Lab 2: Map Projections

1. Purpose

In this lab, we will assess map projection differences for the conterminous US. We will create a map layout with multiple data frames in it (four maps in one page), and we will create a new feature class in different map projections. Aside from subtle visual alignment differences, each projection's areas will be different. We will compare the spatial differences by "calculating" the area of the US and a special test shape.

2. Brief overview of coordinate systems and projections in ArcGIS

Geospatial data are encoded with certain units. The spatial components of each feature class (lines, points) are projected using a mathematically defined coordinate system transformation. The earth is round and maps are flat. Map projections flatten the round earth. ArcGIS recognizes a bewildering number of projections and coordinate systems, but in practice only a limited subset of these are used. It is often the case that geographic data are converted from one projection to another – or, to put it differently – to convert data that is ‘flattened’ one way into data that is ‘flattened’ another way.

ArcGIS has attempted to simplify working with data in different projections by “projecting on the fly”. Essentially ArcGIS will try to recognize what projection your data have and then convert the data to the projection you are working in. The “on the fly” part means that ArcGIS does not make the conversion permanent. Usually this works, sometimes it doesn’t. Often, it misleads you into thinking all your data are in the same projection when they are not.

When you add data to ArcMap it is ‘contained’ in a Data Frame. Recall from the first lab that there are two view options in ArcMap: one is Data View and the other is Layout View. When you are in Layout View you can see the Data Frame that contains your data. Think of the Data Frame like a window on your data. You can resize the frame and move it around in the layout. You can also add other Data Frames to the same map layout. Each Data Frame has its projection it uses to draw the feature layers in it. You can change the projection of the Data Frame but this does not change the actual projected units coded in the feature class – it only changes the projection that you are viewing the data with - in that Data Frame. This is the “on the fly” part.

Some of the features used in this lab have no projected coordinates, but rather have feature coordinates stored in latitude and longitude spherical coordinates (degrees, minutes, seconds, or decimal degrees). This is called the Geographic Coordinate System (GCS). If, however, for calculating areas or precise distances, this is not an appropriate coordinate system. You need a flat planar system, i.e. you need a Projected Coordinate System to do this. Square degrees are meaningless, and for most people a distance specified in degrees is also meaningless. All projection operations are based on spherical coordinates, and so this lab begins with feature classes in GCS, and then moves to transforming these data into projected coordinate systems.
3. Data download and lab preparation

Get the data

Create a new folder for your Lab 2 work. Download and unzip lab2.zip into your work folder. Create a folder connection to the data.

Open ArcMap and look at the feature classes for this lab

You should see a file geodatabase named “us_parks_cities” with three feature classes in it.

Recall the previous lab – from the Catalog window in ArcMap you can bring up the Properties of a feature class. Using the Properties window, find the XY Coordinate System of each of the three feature classes:

<table>
<thead>
<tr>
<th>Question 1: What is the name of the XY Coordinate System of each of the three feature classes?</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. cities</td>
</tr>
<tr>
<td>b. USA_48</td>
</tr>
<tr>
<td>c. USA_parks</td>
</tr>
</tbody>
</table>

4. Setting the projection of a Data Frame

Make sure you have a new empty map in ArcMap and then go to the Layout View. You should see a rectangle on the page with eight little blue squares at its corners and edges -- one on each corner and one in the center of each edge. The little blue squares, and the dashed blue line through them indicate that the Data Frame rectangle is ‘selected’.
Right-click the mouse inside this rectangle and select “Properties” from the popup menu. A window opens up whose title is “Data Frame properties”. It has several tabs. Select the tab for “Coordinate System”. This tab displays the coordinate system (geographic or projected) that the Data Frame is using. Since no data has been added to the Data Frame, it has no coordinate system. Under the heading for “Current coordinate system” it says “No projection”.

Click on “Cancel” to close the Data Frame Properties window.

Let’s look at the same Data Frame properties another way. Go to the TOC window in ArcMap and right-click on the “Layers” entry and select “Properties” in the pop-up menu. Notice that the window that pops up is titled “Data Frame Properties” – the same as the last step. Again, look at the tab for “Coordinate System” and see that the Data Frame has “No projection”. Click on the tab for “General” and notice that the Name of the Data Frame is “Layers” and that the Units for the Map are “Unknown Units”
Click “Cancel” to close the Data Frame Properties window.

This empty map document currently has one empty Data Frame, named “Layers”. You have just opened the Properties window and checked the projection and map units of that Data Frame in two different ways.

Now, let’s add some data to the Data Frame. Drag the cities feature class from the catalog window into the map window. ArcMap draws the points that are in the feature class in the Data Frame. Notice that cities now appears in the TOC.

Check the Data Frame Properties and find the projection that is now used in the Data Frame. And check the Units for the Map.
We are going to repeat the process we did with the cities feature class only this time with the USA_48 feature class. Start a new map document (Hint: use the “New Map File” icon in the toolbar and don’t save the previous map you were working on). In your empty map document, check the properties of the Data Frame to see that there is “No projection”. Close the properties window. Drag the USA_48 feature class from the Catalog window to the map window. You may see a popup box:

This warning message means that ArcMap has detected that USA_48 does not have spatial reference information. This means that there is no defined coordinate system or projection associated with this feature class. This is consistent with the properties of the feature class we saw from the Catalog window (revisit Question 1). Dismiss the warning by clicking OK.

ArcMap draws a map of the states – with a rather peculiar-looking state in the middle! Check the properties of the Data Frame. Notice the Coordinate System of the Data Frame is “Unknown” – but the box under “Current Coordinate System” also says something about missing spatial reference information. Check the Map Units for the data frame – they are “Unknown Units”.

At this point, you should proceed to start another new empty map and see that, when the USA_parks feature class is added to the unused Data Frame, the coordinate system and Map Units of the Data Frame are set to the Coordinate system of the USA_parks feature class. You could also discover that if you remove the USA_parks feature class from the Data Frame that the coordinate system for the Data Frame remains set to the Coordinate System of USA_parks.
Now, let’s put two feature classes in the Data Frame. Create a new map document again (don’t save the old one). First, drag the *USA_parks* feature class to the map. Second, add the *cities* feature class to the map. The TOC window should show *cities* and *USA_parks* in the ‘Layers’ data frame.

Now, check the Projection and Map units of the ‘Layers’ Data Frame. Then, in the Catalog window, check the Projection and Map Units of the *cities* feature class.

**Question 3:**

a) What is the projection of the Data Frame now?

b) What is the coordinate system of the *cities* feature class in the Catalog?

Recap:

In ArcMap, the TOC shows which layers that have been added to the map document for viewing. These layers are grouped into one or more Data Frames. By default, the TOC starts with an empty Data Frame called "Layers". The first feature class added to Layers defines the data frame's projection and coordinate system. In this case, the first feature class added was *USA_parks*. When you added the *cities* feature class to the map, ArcMap then reprojected “on the fly” the *cities* layer to the projection of that data frame (which was set when *USA_parks* was added). The *cities* feature class is only reprojected in memory, using a mathematical equation, for use in that Data Frame in this map in this current ArcMap session. Important: The geometry files of this feature class in the geodatabase are not physically changed in this process. We will learn how to physically reproject feature classes later using ArcToolbox.

**5. Define spatial reference**

Again, start a new empty map in ArcMap. (don’t bother saving the old map.)

Remember, the *USA_48* feature class is missing projection information. We will supply the correct projection for *USA_48*. Right-click on the *USA_48* feature class in the Catalog window and select Properties. Click on the XY Coordinate System tab. We just happen know that the correct projection for *USA_48* is the same projection as used for the *cities* feature class.
Click the “Import…” button and browse to the cities feature class in the usa_parks_cities geodatabase.

Click on the “Add” button.

You are returned to the Feature Class Properties window for USA_48. Notice that the name of the XY Coordinate System is now shows ‘GCS_North_American_1983’. When you click on “OK” in the Feature Class Properties window, ArcMap will store that projection with the USA_48 feature class.

It is important to understand at this point that the coordinates used inside the geometry of USA_48 have not been changed. All we have done is to “define” the correct projection for that feature class in the geodatabase.

Now, add the USA_48 feature class to the empty map and then check the projection of the “Layers” Data Frame. The projection of the Data Frame should be ‘GCS_North_American_1983’. Note that in the middle of USA_48 there is an odd shape. This is referred to as the test feature – it looks like a sideways ice-cream cone. The test feature will help you visualize the results of different projections. Both the roundness and the direction it points will change depending on the projection.

6. Changing how the map looks

Change the colors (Symbology)

Right-click on the USA_48 layer in the TOC, and choose Properties then open the Symbology tab. Under Categories, choose "Unique values“. In the pull-down menu under Value Field choose
STATE_ABBR. Click the ‘Add Values...’ button at the bottom (do not click on the “Add All Values”). The test feature's STATE_ABBR attribute has been assigned ‘ZZ’, select it from the list and click OK. Double-click on it on the color patch for it and make it a dark color. Then double-click on the color patch for <all other values> and change it to a light color. Click Apply, then click “OK” to close the Layer Properties box.

Change display units, print layout

Now we will change the data frame's display units. Open up the Data Frame Properties window of the “Layers” data frame. Go to the General tab. In the ‘Units’ area, set Display to ‘Miles’. Notice that you cannot change Map Units. Display Units can be whatever you want, but the Map Units are those of the Data Frame’s projected units.

After you change the Display units, go to File → Page and Print Setup, change the page alignment from Portrait to Landscape.
Make sure you are in Layout View. Warning: getting used to navigating in Layout View can be frustrating. There are two toolbars, one works for Data View and the other for Layout View. PLEASE ASK FOR HELP if you are confused with this part.

We are going to use the ruler and guides to section the layout into four sections. (A demo of this during the lab will help.) Each section will get a view of the lower 48 states in a different projection. Turn on the rulers and guides in Layout View using View → Guides, and View → Rulers. First put guides 0.50 inches in on all sides (click on the ruler guide on the edge of the window and the appropriate dash). Next, divide the page into quarters – the center of the page is 5.5 inches for left-right side and 4.25 for the top-bottom side (you will have to make it 4.30 inches since ArcMap will not let you select 4.25 inches). Using the Select Elements tool, arrange the first Data Frame (the dashed rectangle containing your data is visible in Layout View) so that it takes-up about a quarter of the page. You should find that the Data Frame snaps
to the guidelines as you move the border close to it. Insert a scalebar. Scales usually have round even numbers. Make the scalebar have Metric units.

After you get through positioning the data frame and the scale reference, set the Map Document Properties to use relative path names and then save this map document in your work area.

**Question 4:**

a. What is the purpose of guidelines?
b. Why would you leave a one-half inch margin on a page instead of taking up the full page?

**Add a graticule**

A graticule consists of meridians and parallels. Add a graticule that has 15 degree spacing along the x-axis (meridians) and 10 degree spacing along the y-axis (parallels).
To do this, open the Data Frame Properties. Select the Grids tab in the dialog. There should be no graticule defined because we started from an empty map. Click on ‘New Grid’ to open the “Grids and Graticules Wizard”. Under ‘Which do you want to create?’ make sure “Graticule: divides maps by meridians and parallels” is selected.

Click Next and set the latitude interval to 10 degrees and the longitude interval to 15 degrees. Click the Style button and select the “Road Unpaved” style.
After you’ve specified the intervals and changed the line style to a lighter gray and dashed line, click ‘Next’. Uncheck both Major division ticks and Minor division ticks. Change the Text style to No Color.
Then click Next, then Finish, then Apply, then OK.

The graticule will be visible as simple gray lines. This is nothing more than a reference. At this page size, a graticule would not serve the purpose if it were cluttered with tic marks and text. A simple grid will enable you to see the differences in the geometry. You can only see the graticule in Layout View.
Question 5:

In making the graticule with the graticule Wizard, how were the text labels made invisible?

Save your work in this map document. (click on the “Save” icon, -or- press Ctrl-S, -or- use File→Save)

7. Copying Data Frames

We used Catalog to define the projection of the USA_48 feature class as "Geographic". When you added USA_48 to an empty Data Frame, you set the coordinate system of the Data Frame. You are going to add three more data frames, each with a different projection.

Let’s change the name of this Data Frame to “Geographic”. Use the Data Frame Properties window, go to the “General” tab, and replace the name “Layers” with “Geographic” and click OK. Now the TOC shows the name of the Data Frame.
It is important to remember at this point that there are two facets to ArcMap: what you see (Display) and the actual data (the feature classes). Manipulating display projections is different than physically transforming actual data, stored in your geodatabase, from one projection to another.

In the TOC, right-click on the ‘Geographic’ data frame and choose Copy. Now right-click in the white area of the map and choose Paste.

Position the data frame in the upper-right quadrant -- it should snap in cleanly with the guidelines. Rename the new data frame from "Geographic" to "Albers".
Paste the copied data frame two more times so all four quadrants have data frames (but only one will have the scale). Rename the bottom left data frame to "Lambert" and the bottom right data frame to "Robinson".
8. Reprojecting layers with Data Frame Properties

All the layers contained within the new data frames you just copied will be projected by changing the projection of the data frame. Think of the data frame like a window on your data. Although the same feature class from the Catalog with its geographic projection is used in each Data Frame, you can change how each Data Frame displays using any projection or measuring unit. To physically change the data to be encoded in a new projection requires that we create a new feature class in your geodatabase. We can do this with the “Project feature” tool in ArcToolbox. Another way is by changing the data frame projection, then exporting the feature class, as shown below.

Reproject to Albers

To change the display projection of Albers data frame, open the Data Frame Properties window for the Albers data frame. Go to the Coordinate System tab to view the projection. Choose a projection from those that are predefined (click the plus sign next to Predefined folder in the coordinate system window). Go to Projected Coordinate Systems. In the Continental subgroup choose North America.
Choose a "USA Contiguous Albers Equal Area Conic" and click Apply.
Change the units that are displayed (in the General tab of the same dialog) to Kilometers. Select the General tab from the Data Frames Property dialog and change Display units.

Notice that the Map Units are now Meters (they are dimmed, in the field directly above the Display units you just changed). You can use kilometers, or nautical miles, or whatever unit you want for the Display units. The effect of this is to change the scalebar's units or the measurement tool’s units (the displayed units in other words). We only need one of our inset maps to have a scale bar because this will not change--the extent for each of the four data frames for the final map will be exactly the same.

Export the projected dataset
In order to create a new feature class in this Albers projection, we will export the "visually" projected data (i.e., ArcMap's "on-the-fly" projection). In the TOC, right-click on the USA_48 feature class in the Albers data frame and go to Data → Export Data...

The default action in the box is to output a feature class named “Export_Output”, in the same geodatabase (in this case the us_parks_cities geodatabase). This is not a very useful name.

![Export Data dialog](image)

Change the Output feature class to “USA_48_albers”, in the same geodatabase as the original USA_48 feature class. This is a way of denoting that that the projection of this new feature class is an Albers projection.

**Important Step:** In the Export Data dialog, in the choices under “Use the same coordinate system as:”, choose "the data frame". If you have to browse to the geodatabase where you will save the file, be sure that the "Save as type" field is "File and Personal Geodatabase feature classes".
Click “OK”. ArcMap creates the new feature class. Click "Yes" when asked if you want to add it this feature class to the data frame. Notice that it is added to the Albers data frame.

You can import the symbology color scheme from the GCS version of USA_48 to your new, projected Albers version by going to USA_48_albers Properties, Symbology tab, then click the Import button. Then select USA_48 feature class for the import symbology definition. Click OK. You should see the USA_48_albers feature class symbolized with the color scheme from USA_48.

Remove the original Geographic dataset (right-click on USA_48, then Remove) so that only USA_48_albers is in the Albers data frame.
If you check the Catalog window, you should see the new feature class in the geodatabase:

Reproject to Lambert

Select the Lambert data frame in the lower left.

Bring up the Data Frame Properties for the “Lambert” data frame. As with the Albers data frame, click on the Coordinate System tab to view or change the projection.

This time choose "USA Contiguous Lambert Conformal Conic". Click Apply and OK.
Once you have the *Lambert* Data Frame set with Lambert projection, Export the Data and (Important Step) select "the data frame", and put "_lambert" at the end of the new feature class you are creating.
Click Yes when asked if you want to add it this data frame. Remove the original Geographic feature so only the *USA_48_lambert* is in the data frame.

You may have to re-symbolize to get the ‘ZZ’ feature.

**Reproject to Robinson**

For the last data frame (in the lower right quadrant) repeat the procedure you've used for the last two – but this time use the "Robinson" projection under World projections.
Follow the same procedures to export a reprojected USA_48 to the Robinson projection, calling it USA_48_robinson in the geodatabase. Re-symbolize if necessary.

Recap:

At this point you should have four data frames in your map, three of which contain data with a different projection. You can make sure that each data frame shows the same extent by selecting it and clicking the Full Extent button (the globe in the map tools). You might need to click on the “Zoom Whole Page” button (in Layout View) to make the map fit the window on the screen. The symbology should be identical for each data frame.

When you do Data → Export Data ... you are creating a new feature class that is reprojected. You control the projection it is reprojected to with the choice of “this layer’s source data” or "the
data frame" in the Export Data dialog box. Exporting and reprojecting has mathematically changed the geometry of the feature to the new coordinate system and set the Map Units.

Question 7:

What would be the coordinate system of the exported feature class if you left the selection at "this layer's source data"?

Does your ArcMap layout look like this?

9. Calculate Area

In order to assess the three projected coordinate systems, you are going to calculate two statistics:
1) The area of the test shape
2) The area of the continental US, not including the test feature

In order to get these statistics you will need to update the Attribute Tables for each of the datasets. The Map units of the Data Frame with the Geographic coordinate system are decimal degrees. These units are not based on planar coordinates, which are needed for calculating area, and so the area of these polygons will not be calculated.

The projected features (*.albers, *.lambert, *.robinson) have meter units and are projected in three different planar coordinate systems. The area attributes for the polygons in these feature classes are stored in the Attribute Table of each feature class -- one row for each polygon.

**Update Area for the features**

We will first recalculate the Area column for USA_48_albers. This will change the existing Area attribute values from square decimal degree to square meters.

1. Right-click the layer whose attributes you want to update (e.g., USA_48_albers) and click Open Attribute Table.

2. Find the field called “Area” and right-click the field heading and click Calculate Geometry. You may be warned about doing a calculation outside of an edit session. Just click “Yes”.

3. Be sure that the "Use coordinate system of the data source" option and the "Square Meters [sq m]" options are selected (these are the default that come up). Click OK.
The Area values should be large numbers. If not, you probably did not export the features with the "data frame" coordinate system (repeat Step 8 if necessary). You will probably have to drag the column width of the field to make it wide enough to show all the digits.

Repeat these procedures for the other two projected feature classes (*.lambert, *.robinson).

10. Summarizing attribute table statistics

So far you have updated the Attribute Tables of the projected datasets with the areas, in square meters, of each feature. (you have 3 datasets, so 3 attribute tables). You are going to create an Excel spreadsheet that compares the areas of the three projections.

First – getting the areas from the attribute tables:

Open the Attribute Table for USA_48_albers. Right-click on the Area column heading in the Attribute table and choose Summarize...
In the Summarize dialog, notice that the field being summarized is “AREA”. Under “2. Choose one or more summary statistics …” check the ‘First’ box under STATE_ABBR. For the output table, click on the little folder icon to navigate to where to save the file. For “Save as type”, select ‘Text File’. Then name the file ‘albers_summarize_area.csv’. (notice the file extension “.csv”)

Click on ‘Save’.
Click on ‘OK’ to have ArcMap export the summary of the AREA field.

Click NO when asked if you want to add the table to the map.

Repeat this procedure with the Lambert and the Robinson areas. You should have three files in your work directory that Windows recognizes as Microsoft Excel files:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>usa_parks_cities.gdb</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>albers_summarize_area</td>
<td>Microsoft Excel Comma Separated Values File</td>
<td>2 KB</td>
</tr>
<tr>
<td>lambert_summarize_area</td>
<td>Microsoft Excel Comma Separated Values File</td>
<td>2 KB</td>
</tr>
<tr>
<td>robinson_summarize_area</td>
<td>Microsoft Excel Comma Separated Values File</td>
<td>2 KB</td>
</tr>
</tbody>
</table>

Second – combine the 3 summaries in Excel

Open the three summarized attribute table files (albers_summarize_area, lambert_summarize_area, robinson_summarize_area) with Excel. You will need to Sum the Area
column and combine the data into one worksheet. Ask your instructor for help with sum functions in Excel if you do not know how to do this step.

You need to report two statistics: one is the area of the test shape (ZZ) and the other is the areas of other 49 states (includes the District of Columbia) and the total area of the 49 states for each projection. Remember that your units are square meters. Convert these to hectares by dividing by 10,000 (there are 10,000 square meters per hectare). Other conversions are available at the following site:

NODC Unit Conversion Guide - http://www.nodc.noaa.gov/dsdt/ucg

Below is an example of what your spreadsheet could look like, but the format is up to you. The screenshot does not show the actual data that you will get – it’s just an example. Consult the instructor if you need assistance. Exporting and importing GIS attribute data with Excel is an invaluable skill.
<table>
<thead>
<tr>
<th></th>
<th>State</th>
<th>Lambert</th>
<th>Albers</th>
<th>Robinson</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>ZZ</td>
<td>4,390,121</td>
<td>20,959,432</td>
<td>3,965,804</td>
</tr>
<tr>
<td>5</td>
<td>AL</td>
<td>5,707,626</td>
<td>32,611,581</td>
<td>18,557,971</td>
</tr>
<tr>
<td>6</td>
<td>AR</td>
<td>35,834,888</td>
<td>10,413,317</td>
<td>12,841,960</td>
</tr>
<tr>
<td>7</td>
<td>AZ</td>
<td>5,795,558</td>
<td>18,152,588</td>
<td>21,685,832</td>
</tr>
<tr>
<td>8</td>
<td>CA</td>
<td>27,458,728</td>
<td>31,963,229</td>
<td>6,585,103</td>
</tr>
<tr>
<td>9</td>
<td>CO</td>
<td>28,509,327</td>
<td>5,699,567</td>
<td>21,669,510</td>
</tr>
<tr>
<td>10</td>
<td>CT</td>
<td>1,522,027</td>
<td>3,955,998</td>
<td>576,600</td>
</tr>
<tr>
<td>11</td>
<td>DC</td>
<td>6,297,981</td>
<td>17,474,334</td>
<td>1,794,632</td>
</tr>
<tr>
<td>12</td>
<td>DE</td>
<td>7,132,406</td>
<td>4,485,556</td>
<td>20,896,009</td>
</tr>
<tr>
<td>13</td>
<td>FL</td>
<td>6,716,926</td>
<td>10,061,149</td>
<td>37,877,425</td>
</tr>
<tr>
<td>14</td>
<td>GA</td>
<td>18,498,503</td>
<td>18,379,934</td>
<td>28,234,171</td>
</tr>
<tr>
<td>15</td>
<td>IA</td>
<td>18,431,901</td>
<td>10,461,636</td>
<td>34,398,372</td>
</tr>
<tr>
<td>16</td>
<td>ID</td>
<td>28,412,211</td>
<td>25,839,417</td>
<td>35,203,440</td>
</tr>
<tr>
<td>17</td>
<td>IL</td>
<td>17,125,579</td>
<td>1,925,747</td>
<td>15,945,482</td>
</tr>
<tr>
<td>18</td>
<td>IN</td>
<td>27,013,025</td>
<td>14,847,220</td>
<td>3,028,935</td>
</tr>
<tr>
<td>19</td>
<td>KS</td>
<td>21,281,611</td>
<td>16,509,870</td>
<td>22,842,137</td>
</tr>
<tr>
<td>20</td>
<td>KY</td>
<td>6,051,406</td>
<td>18,211,354</td>
<td>12,440,248</td>
</tr>
<tr>
<td>21</td>
<td>LA</td>
<td>26,963,257</td>
<td>22,116,950</td>
<td>12,272,130</td>
</tr>
<tr>
<td>22</td>
<td>MA</td>
<td>25,577,331</td>
<td>13,367,204</td>
<td>22,785,307</td>
</tr>
<tr>
<td>23</td>
<td>MD</td>
<td>38,142,678</td>
<td>37,982,578</td>
<td>35,147,722</td>
</tr>
<tr>
<td>24</td>
<td>ME</td>
<td>26,830,818</td>
<td>30,892,183</td>
<td>4,978,607</td>
</tr>
<tr>
<td>25</td>
<td>MI</td>
<td>32,089,843</td>
<td>4,585,633</td>
<td>37,522,076</td>
</tr>
<tr>
<td>26</td>
<td>MN</td>
<td>28,220,341</td>
<td>10,061,177</td>
<td>12,272,130</td>
</tr>
<tr>
<td>46</td>
<td>TX</td>
<td>30,096,918</td>
<td>32,755,707</td>
<td>39,662,159</td>
</tr>
<tr>
<td>47</td>
<td>UT</td>
<td>23,800,098</td>
<td>23,084,894</td>
<td>11,327,140</td>
</tr>
<tr>
<td>48</td>
<td>VA</td>
<td>34,485,425</td>
<td>32,527,861</td>
<td>29,584,794</td>
</tr>
<tr>
<td>49</td>
<td>VT</td>
<td>2,962,876</td>
<td>10,502,319</td>
<td>37,300,659</td>
</tr>
<tr>
<td>50</td>
<td>WA</td>
<td>9,377,808</td>
<td>9,666,527</td>
<td>23,645,053</td>
</tr>
<tr>
<td>51</td>
<td>WI</td>
<td>32,232,079</td>
<td>27,880,786</td>
<td>17,367,063</td>
</tr>
<tr>
<td>52</td>
<td>WV</td>
<td>38,950,915</td>
<td>24,407,897</td>
<td>32,737,100</td>
</tr>
<tr>
<td>53</td>
<td>WY</td>
<td>6,905,881</td>
<td>24,767,347</td>
<td>34,142,161</td>
</tr>
</tbody>
</table>

Total 48: 1,007,384,813

55

56

57
11. Refine the final map and export a PDF map

Map 1

Make a map from your map layout. Map requirements:

1) Show the four different projections of the Conterminous US and the test feature, all on the same page.

2) Show a scalebar and numerical scale on the unprojected Geographic map (upper-left quadrant).

3) Add a title for each Data Frame (maybe its projection name for example) and a title for the whole map.

3) Include the area of the test feature on each of the three projected data frames within the map's frame. Be sure to label the units of area. Small fonts are fine, but don't go below 6 (that's too small).

Export the map to a PDF file. To export the map, go to File \rightarrow Export Map. Name the map, beginning with your **LAST NAME**, choose PDF as the type and set it to 150 dpi resolution. Then click Save.

12. To turn in

- A Word document with your answers to the 7 questions.
- One map exported in PDF format, 150 dpi that is your completed 4-panel projections
- The Excel file showing the areas for each of the three projected features with the hectares conversions.

Submit electronic files via email to your instructor, with the subject "G387, Lab 2, [your last name]".

**Please name your file attachments with your last name first, followed by whatever descriptive text that you want to include in the file name (e.g., "clark_lab2.doc").**

Credits: The original version of this lab module was developed by the Department of Geography at UC Santa Barbara. Used with permission. The original UCSB lab was tailored for instruction at Sonoma State University by Matthew Clark and expanded for ArcGIS 10 by George Riner, Center for Interdisciplinary Geospatial Analysis (CIGA).